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Introducción 

 
 

BioP es una herramienta dedicada a 
la predicción potencial de especies 
biológicas.  
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I. Introducción 
 
Bienvenido a la Guía de Usuario de BioP. Esta guía esta pensada en facilitar el 
uso de la aplicación de una manera correcta y óptima. BioP es un nuevo software 
diseñado para obtener la predicción potencial del hábitat de una especie o un 
grupo de especies. Dado i) observaciones de especies, ii) las condiciones 
ambientales en un área (como temperatura, suelo, etc., aquí llamado covariables), 
iii) información a priori acerca la presencia e ausencia de la(s) especie(s) y iv) su 
sesgo de muestrea, podemos predecir donde podría existir la especie en un área. 
A diferencia de otros programas o aplicaciones similares, BioP contempla lo que 
es la información a priori,  y el sesgo espacial de una cohorte de especies. A 
cambio BioP ofrece 3 salidas para el análisis de los datos: Predicción potencial, 
certidumbre de la predicción potencial y un potencial priori. 
 
BioP le permite hacer: 

 Construir paquetes de covariables (o coberturas) categorizadas, también 
modificar un paquete previamente diseñado. Este paquete de covariables 
será llamado en adelante como archivo de covariables. Los tipos de archivo 
que reconoce BioP para diseñar el archivo de covariables son ASCII grid. 

 Usar mapas de información a priori, Un experto de las especies puede dar 
información a priori acerca donde en una región sea probable que esté 
presente o ausente una especie. Se cuenta con una herramienta que permite 
diseñar el archivo de información a priori.  Los tipos de archivo que reconoce 
BioP para hacer el archivo de información a priori son ASCII grid. 

 Mapas del sesgo Espacial.  Unas regiones de un área tienen más alta 
probabilidad de ser visitado por científicos que otras regiones (por ejemplo 
lugares cerca a las carreteras y ciudades principales). Esto lo podemos 
traducir a  una probabilidad de la frecuencia de visitas a zonas donde existe 
un grupo de especie. Los tipos de archivo que reconoce BioP para hacer el 
archivo de sesgo son ASCII grid. 

 Exportar los resultados en archivos de distintos formatos, los soportados por 
BioP son: Mapa de Bits (*.bmp), Archivo de Texto (*.txt), Excel Microsoft 
(*.xls), ASCII grid (*.asc). 

 Multisesión de predicciones. 
 Manejar varias especies a la vez. 
 Multilenguaje. 
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I.1. Quien es BioP? 
 
La versión actual de BioP es desarrollada y en constante mantenimiento por 
Christian Omar Gómez, con la ayuda y supervisión del Dr. Andrés Christen, Dr. 
Miguel Nakamura y el Dr. Maarten Blaauw (todos parte del CIMAT). La primera 
versión de BioP fue creada y desarrollada por el Dr. Jorge Argáez (Argáez 2003, 
Argáez et al. 2005). El modulo de Sesgo Espacial esta basado en el código hecho 
por el M.C. Daniel Fernández. El desarrollo actual esta apoyado por SEMARNAT-
CONACYT.  
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II. Comenzando 
 
Esta sección provee una guía de cómo instalar e iniciar BioP.  
II.1. Instalación 
 
BioP es distribuido en un archivo ejecutable (.exe), el cual hace la instalación de la 
aplicación junto con los archivos de configuración. Este archivo ejecutable se 
puede obtener de la siguiente URL: http://www.cimat.mx/~chrisom/download.html . 
En este sitio esta en constante actualización de acuerdo a los requerimientos 
comunes de los usuarios. Esta soportado desde Windows® 98 hasta Windows® 
XP 
 
Instalando BioP 
 

1. Ejecutar el archivo .exe de BioP (SetupBioP_eg.X.X.XX.exe o 
SetupBioP_sencillo.X.X.XX.exe) 

2. Generalmente se puede aceptar en todas las opciones predeterminadas sin 
hacer cambios. 

3. BioP crea un directorio (C:\BioP) en el volumen C: de Windows®, en caso 
de tener mas de dos volúmenes, se recomienda que se haga en C. Esto es 
debido a que BioP obtiene la información de este directorio para poder ser 
multilenguaje, aparte de instalar sus propias librerías para un correcto 
funcionamiento. 

 
 
II.2. Iniciando la aplicación 
 
Para ejecutar la aplicación, la instalación provee varias maneras de hacerlo, 

mediante el icono en el escritorio de trabajo , o mediante la ruta: Inicio->Todos 
los Programas->BioP->ProjectBioP.exe.  
 
Al iniciar la aplicación BioP, automáticamente esta en sesión abierta para 
comenzar a introducir los archivos necesarios para la predicción. En la siguiente 
parte se explica el entorno visual, y los pasos a seguir para realizar dicha 
predicción. 
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III. Usando BioP 
 
Esta sección ofrece una exploración detallada de las herramientas y 
características de BioP. Se ilustra como abrir y crear proyectos, configurar las 
preferencias en la aplicación, y crear los archivos de entrada con las herramientas 
proporcionadas. Cuando se haya terminado de leer esta sección debería ser 
capaz de comenzar a realizar sesiones rápidas en BioP. Se incluye un ejemplo. 
 
 
 
III.1. Pantalla principal. 
 
Cuando se inicia BioP, la primera pantalla que se muestra, es la Pantalla principal 
(Figura 1). Es un punto de partida para acciones como: 

 Cargar el archivo de covariables. 
 Cargar el archivo de sesgo. 
 Cargar el archivo de información a priori. 
 Cargar el archivo de registros de presencia. 
 Ejecutar la aplicación. 
 Explorar por los archivos de entrada y los resultados. 
 Exportar los archivos. 
 Cambiar las preferencias de la aplicación. 
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Descripción de la pantalla. 
 
 

 
 

Figura 1. Pantalla principal de BioP. 
 

 
III.1.1. Barra de menú 
 

 
 

Figura 2. Barra de menú de pantalla principal 
 
 

Esta barra contiene todas las funciones y tareas que puedan realizarse dentro de 
BioP, desde hacer la entrada de archivos, exportación de archivos, ejecución de la 
aplicación hasta cambiar el idioma (actualmente solo soporta dos idiomas: español 
e ingles).  En caso de solo manejar teclado, es recomendable hacer las tareas vía 
barra de menú (Figura 2). 
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 Archivo. Contiene las opciones de cargar los archivos de entrada. Otra opción 

es exportar los resultados (Probabilidad Predictiva, Certidumbre, Potencial 
Priori), en distintos formatos (.txt, .asc, .xls). También puede exportar la 
imagen actual, es decir, el mapa que se encuentra en la zona de mapas. 

 Ejecutar. Permite hacer la ejecución de la predicción. Esta se habilita cuando 
están todos los archivos necesarios. Eliminar un archivo, en caso de hacerle 
modificaciones al mismo, o cargar otro. Eliminar todos los archivos, en caso 
de requerir una sesión nueva, se borran todos archivos actualmente 
cargados. 

 Herramientas. Contiene las herramientas para poder elaborar los archivos de 
entrada de BioP. 

 Preferencias. Son las opciones para poder cambiar el entorno grafico de 
BioP. 

 
 
III.1.2. Barra de herramientas. 
 

 
 

Figura 3. Barra de herramientas de la pantalla principal. 
 
 
La figura 3 muestra la barra de herramientas que contiene las tareas más 
importantes que pueden realizarse dentro de BioP. Las opciones o botones que se 
muestran pueden tener cualquiera de los dos estados: habilitado o en colores, y 
deshabilitados o escala de grises. A continuación se describe la función de cada 
una de las opciones: 
 
 
Área de Carga. 
 

 Carga el archivo de covariables. Existen dos modos para la carga de los 
archivos: 
 

 Modo RAM. Todos los archivos serán cargados en la memoria principal 
y por lo tanto su ejecución será bastante rápida. Otra ventaja de esta 
opción es dibujar el mapa al instante que se van cargando los 
elementos. Recomendable para mapas de dimensiones pequeñas. 

 Modo HD-RAM. Parte del archivo de covariables es cargado en 
memoria principal, mientras la parte restante se lee directamente de 
disco duro. La ventaja de esta opción es que no utiliza mucho recurso 
de memoria principal, pero es lento a comparación del modo RAM. 
Recomendable para mapas de dimensiones grandes. 
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También las covariables son listadas en el explorador con el fin de poder observar 
su comportamiento en la zona de mapas. 
 

 Carga el archivo de sesgo. Al activar esta opción muestra dos opciones de 
cargar el archivo ya sea Calculado que se selecciona en caso de tener el archivo, 
o haya sido generado con el Administrador de Sesgo, o puede ser No Informativa, 
que es en caso de no tener el archivo, y se toma toda la región con un valor 
uniforme. 
 

 Carga el archivo de priori. Al activar esta opción muestra dos opciones: 
Calculado que se selecciona en caso de tener el archivo, o haya sido generado 
con el Administrador de Priori, o puede ser No Informativa, que es en caso de no 
tener el archivo, y se toma toda la región con un valor uniforme. 
 

 Carga el archivo de sitios de presencia, y muestra gráficamente en el mapa 
estos sitios con puntos de color verde. En caso de manejar varias especies, se 
muestran puntos en distintos colores verde. También dichas especies son listadas 
en el área de explorador. 
 
 
Área de ejecución. 
 

 Borra todos los archivos que hayan sido cargados. En caso de intentar otra 
predicción con otros datos. 
 

 Borra el archivo que este seleccionado, con el fin de hacerle modificaciones 
o cargar otro distinto.  
 

 Ejecuta la predicción, esta opción se habilita cuando todos los archivos de 
entrada hayan sido cargados. 
 
 
Área de resultados. 
 

 Muestra el mapa de la probabilidad predictiva. 
 

 Muestra el mapa de la certidumbre de los datos. 



 Guía de Usuario de BioP 
 

Pagina 8 

 

 Muestra el mapa del potencial priori. 
 
 
 
III.1.3. Zona de Mapas 
 

 
 

Figura 4. Zona de mapas de la pantalla principal. 
 
 

La figura 4 muestra la zona donde se despliegan los mapas de los archivos que 
han sido cargados, y los mapas de resultados. Para cambiar de un mapa a otro, 

es necesario dar doble clic en el explorador al icono de los mapas.  
 
También muestra la llave con el máximo y mínimo valor, junto con lo colores 
implementado para tener una percepción de los valores dentro del mapa. 
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III.1.4. Explorador 
 

 
 

Figura 5. Explorador de la pantalla principal. 
 
 

Esta es una parte de la ventana principal que esta compuesta por tres pestañas. 
La primera de ellas, es el explorador de archivos y mapas (Figura 5), y permite 
mostrar ya sea dentro de la misma aplicación los archivos, o fuera de ella.  Estos 
son los iconos que representan a cada uno de los elementos. 
 
 

 Representa que opción esta seleccionada actualmente. 
 

 Representa los mapas y pueden ser mostrados al dar doble clic sobre este 
mismo. 
 

 Representa los archivos que han sido cargados fuera de la aplicación, esto 
se hace al dar doble clic sobre este mismo. Se utiliza la aplicación Notepad de 
Windows.  
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 Representa los datos del archivo dentro de la aplicación. Al igual que las 
anteriores es necesario dar doble clic sobre este mismo. 
 
 
III.1.5. Colores del Mapa 
 

 
 

Figura 6. Colores del mapa. 
 
 

En esta sección (Figura 6) se pueden manipular los colores desplegados en los 
mapas. Cuando un mapa es dibujado en la zona de mapas, tiene un color 
predeterminado: estos colores pueden ser sustituidos por otros de su agrado. 
 
Solo tiene que seleccionar el mapa al cual se le aplicara el cambio dentro del 
explorador, cambiar a la pestaña de colores, seleccionar un degradado de los 
mostrados de la lista, y por ultimo presionar el botón de cambiar. 
 



 Guía de Usuario de BioP 
 

Pagina 11 

 
III.1.6. Datos del Mapa. 
 

 
 

Figura 7. Datos del mapa (o mapas) desplegados. 
 

 
La figura 7 muestra la pestaña donde se muestran los valores de los datos que 
representan al mapa. Al mover el ratón sobre cualquiera de los mapas, 
automáticamente se van mostrando los valores de los nodos por los cuales se 
recorre, y las barras en colores se incrementan de acuerdo al valor mostrado. 
 
 
III.1.7. Bitácora o Log 
 

 
 

Figura 8. Log de acciones realizadas. 
 
 

Esta parte de la pantalla principal (Figura 8), va mostrando cada acción que se 
realiza dentro de la aplicación, desde la carga de archivos hasta los mensajes de 
error, con el fin de llevar un control de las acciones que va ejecutando a lo largo de 
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la sesión. Al lado de la bitácora se muestran las coordenadas geográficas por las 
cuales se va recorriendo con el ratón sobre el mapa. 
 
 
III.1.8. Ejemplo de una sesión en pantalla principal 
 
Como se mencionó en secciones anteriores al ejecutar BioP lo hace con una 
sesión abierta, donde solo queda introducir los archivos necesarios para la 
predicción. En esta ocasión se tratara de predecir el hábitat potencial del conejo 
Romerolagus diazi dentro del territorio mexicano siguiendo estos pasos: 
 

1. Se introduce un archivo de covariables previamente diseñado por el 
administrador (ver III.2), y se hace utilizando el botón de cargar archivo de 

covariables  ,  BioP pregunta por el modo que se utilizara para hacer la 
carga de las covariables lo cuales son presentados en la ventana que 
presenta la figura 9. 

 

 
 

Figura 9. Modo de procesamiento de los datos. 
 
 

Al seleccionar el modo RAM automáticamente se ejecuta un dialogo que 
permite seleccionar el archivo a abrir (por default se posiciona la ruta: 
C:/BioP/Covariables/). Los archivos reconocidos por este dialogo son del 
formato .txt. Después de ser abierto el archivo, se agrega al explorador y se 
listan las covariables que contiene para posteriormente ser analizadas. 
También se habilitan los botones restantes para cargar los demás archivos 
faltantes. La siguiente figura 10 muestra como puede verse después de cargar 
las covariables. 
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Figura 10. Covariables cargadas. 
 
2. El siguiente archivo a cargar es el de sesgo espacial (ver III.3) con el botón 

que lo representa , Explicamos más adelante como hacer este archivo; 
podría usar el archivo xxx.txt para este ejemplo. Al igual que las covariables 
después de presionar dicho botón se muestra el dialogo para seleccionar el 
archivo.  La figura 11 muestra un sesgo ya cargado en BioP. 
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Figura 11. Sesgo Espacial cargado. 
 
 

3. El siguiente archivo a cargar es información a priori  que al igual que 
los anteriores tienes su propio administrador que permite crear dicho 
archivo y siguen los mismos pasos (ver III.4).  

4. El último archivo a cargar es el de las presencias registradas de la especie 

. Este archivo debe seguir un formato para que pueda ser leído por la 
aplicación, este formato es como se muestra en la figura 12. 
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Figura 12. Formato del archivo de presencias. 
 
 

Como puede verse en la figura el nombre de la especie no debe llevar 
espacios, y estos pueden ser sustituidos por guiones o guiones bajos.  Le 
siguen la longitud y por último la latitud. El espacio entre estos campos puede 
ser por medio de tabulaciones, comas o espacios. La figura 13 muestra las 
presencias cargadas en BioP, y cada una es representada por puntos verdes. 
En caso de manejar distintas especies, los puntos tienen distinta tonalidad de 
verdes para representar cada especie. 
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Figura 13. Presencias del Romerolagus Diazi. 
 

 
5. Ahora solo queda ejecutar la predicción mediante el botón que realiza esta 

acción . Debe esperar un momento en lo que hace los cálculos y 
puedan ser mostrados en pantalla, esto dependiendo del tamaño de los 
archivos que se estén utilizando. El resultado de esta predicción se 
muestra en la siguiente figura. A primera instancia se muestra el mapa de 
predicción. 

6. Para cambiar a los otros mapas debe presionar los botones con los 

siguientes iconos: ya sea de predicción , certidumbre  o potencial 

priori . Después de analizar sus datos puede cerrar la aplicación o 
iniciar una nueva sesión borrando los datos actuales con el botón de borrar 

todos los archivos . 
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III.2. Administrador de Covariables 
 
Es una herramienta dedicada a elaborar el archivo de covariables.  A continuación 
se muestra la figura de esta herramienta y se explicaran cada uno de sus 
componentes (Figura 14). 
 

 
 

Figura 14. Administrador de covariables. 
 
 

III.2.1. Barra de menú 
 

 
 

Figura 15. Barra de menú del administrador de covariables. 
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Esta barra contiene todas las tareas que pueden realizarse dentro del 
administrador de covariables, como crear nuevos proyectos hasta modificar los ya 
existentes. A continuación se enumeran las opciones que contiene dicha barra: 
 

 Archivo. Contiene las opciones de carga de archivos, así como crear 
nuevos proyectos, o abrir proyectos existentes. 

 
 
III.2.2. Barra de herramientas 
 

 
 

Figura 16. Barra de herramientas del administrador de covariables. 
 
 

Esta barra (Figura 16) contiene las tareas comunes que pueden realizarse dentro 
del administrador de covariables. A continuación se hace una descripción de cada 
uno de los elementos: 
 

 Carga un fólder completo que contengan archivos en formato .asc. 
 

Carga un solo archivo que este en formato .asc dentro de la zona de 
selección. 
 

 Limpia la zona de selección, en casos de crear nuevos archivos de 
covariables. 
 

 Guarda la selección de covariables actual, y listo para ser cargado en la 
pantalla principal. 
 

 Carga de manera automática en la pantalla principal la selección actual de 
covariables. Antes de hacer esta carga BioP pregunta al usuario el modo en que 
se hace el procesamiento de los datos: RAM y HD-RAM (vistos en la sección 
III.1.2) 
 

 Cierra el administrador de covariables.  
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III.2.3. Zona de selección 
 

 
 

Figura 17. Zona de selección. 
 
 

En esta zona (Figura 17) se muestran los archivos .asc cargados en cualquiera 
que haya sido el modo, donde pueden ser seleccionados o deseleccionados para 
crear el archivo de covariables. Dependiendo de que covariable este seleccionada 
se muestra su categorización asignada y su nombre en la zona de datos. 
 
 
III.2.4. Zona de datos 
 

 
 

Figura 18. Zona de datos. 
 
 

Esta pequeña zona (Figura 18) muestra el nombre de la covariable y su 
categorización. En caso de haber cargado las covariables de un proyecto ya 
guardado, las categorías de cada covariable no puede ser modificable debido a 
que ya están categorizadas. En caso de cargarlos de un nuevo proyecto la 
categorización si puede ser modificable, y tiene como predeterminada una 
categorización de 10. 
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III.2.5. Botones de acción 
 

 
 

Figura 19. Botones de acción. 
 
 

Son dos botones que afectan a la zona de selección; el botón Seleccionar Todo 
selecciona todas las cajitas de las covariables, y el botón Deseleccionar Todo 
quita la selección a todas las cajitas de las covariables. 
 
 
III.2.6. Ejemplo de una sesión en el administrador de covariables 
 
A continuación se mostrara una sesión en el administrador de covariables como 
ejemplo, utilizando archivos ASCII grids obtenidos de la página de oficial de 
CONABIO (www.conabio.org). Estos a su vez son almacenados en el directorio 
C:\BioP\Grids. Se activa el administrador de covariables presionando el botón en 

la pantalla principal representado por el icono . 
 
Posteriormente se carga el directorio donde se encuentran los ASCII obtenido de 

CONABIO presionando el botón con el icono , que mostrara la lista de archivo 
en la zona de selección (Figura 17), Se eligen las covariables que sean necesarias 
dando clic en el cuadro y dándole su categorización. Es necesario asignarle dicha 
categorización de acuerdo a los conocimientos del experto sobre la especie a 
estudiar. En la figura 20 se muestra el resultado de las acciones realizadas. En un 
proyecto, cada archivo ASCII tiene que tener la misma resolución y locación. En 
caso de tener archivos que no cumplen esto, hay que preparar los archivos ASCII 
en por ejemplo ArcView (ver apéndice A) 
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Figura 20. Agregando archivos de coberturas (ASCII). 
 

 
Después de configurar cada una de las covariables que formaran el archivo final 
se procede a guardar dicho archivo en el directorio C:\BioP\Covariables\ dando clic 

en el botón con el icono . Esta acción produce un archivo, donde las primeras 
líneas son los nombres de las covariables y su correspondiente categorización, la 
segunda parte del archivo muestra las coordenadas geográficas de cada nodo o 
celda y su lista de covariables categorizadas, y la última línea es representada por 
valores binarios donde 0 representa al mar y 1 representa tierra firme. Ver figura 
21. 
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Figura 21. Formato de un archivo de covariables. 
 

 
III.3. Administrador de información a priori 
 
Esta herramienta proporciona los componentes necesarios para crea el archivo de 
entrada a BioP, conocido como archivo de información a priori (Figura 22). El 
archivo de información a priori debe estar en formato ASCII y con la misma 
resolución y ubicación que los archivos de los covariables (ver apéndice A). A 
continuación se detallan las partes que componente a ésta herramienta. 
 



 Guía de Usuario de BioP 
 

Pagina 23 

 
 

Figura 22. Administrador de la información a priori. 
 
 

III.3.1. Barra de herramientas 
 
 

 
 

Figura 23. Barra de herramientas del administrador a priori. 
 

 
Esta barra (Figura 23) contiene las tareas más importantes que se realizan dentro 
de la aplicación, tales como el cargado de los archivos importantes como el cargar 
cualquier archivo ASCII que este relacionado con el archivo de la información 
priori previamente diseñado en un GIS y también en formato ASCII.  

 
 

 Carga archivo ASCII. El primer archivo servirá como mascara para delimitar 
áreas de mar, tierra y zonas de incertidumbre. Puede ser uno de los archivos 
ASCII de los covariables.  
 
 
 
Para el archivo el de priori en formato ASCII se deben tener dibujadas dos zonas: 
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 Presencia, donde son dibujadas las zonas donde puede habitar la especie. 
Este archivo debe estar diseñado por un experto de la especie, ya que es 
un archivo importante para tener una correcta predicción de la especie. La 
zona dibujada o polígono dibujado debe contener el valor 1. En la 
herramienta será dibujada con el color verde. 

 Ausencia, donde es muy poco probable que habite la especie, al igual que 
la zona de presencia debe ser dibujada por un experto. Estas zonas debe 
de contener el valor 3. En la herramienta será dibujada de color rojo. 

 En la parte donde no son dibujadas cualquiera de las de las zonas 
anteriores se toma como incertidumbre, y físicamente toman el valor 2.  
BioP automáticamente asigna este valor. 

 

  Quitar archivo. Este botón se encarga de eliminar cualquiera de los archivos 
que han sido previamente cargados. 
 

 Combinar archivos. Este botón se encarga de combinar los archivos 
cargados, prepara el archivo delimitando las áreas de mar y tierra, y las zonas no 
dibujadas dentro del mapa automáticamente se toman como zonas de 
incertidumbre. 
 

  Guardar. Guarda el resultado de que se dibuja en la zona de mapas en 
formato .txt como una tira de datos. 
 

  Carga el archivo de información a priori, en caso de que no haya sido 
cargado durante la sesión actual este botón se encuentra activo, en caso contrario 
se muestra en su estado inactivo. 
 
 

  Cierra el administrador de información a priori.  
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III.3.2. Explorador 
 

 
 

Figura 24. Explorador del administrador a priori. 
 

Muestra una lista de los archivos que ya han sido cargados previamente, así como 
también el resultado de la combinación. 
 
 
III.3.3. Zona de mapas. 
 

 
 

Figura 25. Zona de mapas de administrador a priori. 
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Esta zona dibuja los mapas y los polígonos que se forman con los archivos 
cargados, así como también el mapa resultado. El manejo de esta herramienta es 
muy sencillo por lo tanto no es requerido un ejemplo. 
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Apéndice A 
 
1 Uso de la primera vez 
 
1.1 Instala ArcView 3.x con la extensión Spatial Analyst (haz custom setup y 

incluye GRID I/O). 
1.2 Muchos usuarios en la modelación de nichos ecológicos probablemente ya 

tienen Desktop GARP en su computadora. Si no, instala Desktop GARP 
(http://www.lifemapper.org/desktopgarp). 

1.3 Copia GarpDataSets.avx (se encuentra en la carpeta de GARP, por ejemplo 
C:\Program Files\Desktop Garp) a C:\ESRI\Av-gis30\ArcView\Ext32. 

1.4 Abre ArcView, activa las extensiones Spatial Analyst y Geoprocessing (File -> 
Extensions->Spatial Analyst y Geoprocessing->OK), y despues activa la 
extension GarpDataSets (File->Extensions->GarpDataSet->OK). Tiene que 
aparecer un submenú GARP en ArcView. 

1.5 Si no ha aparecido el submenú GARP despues punto 1.4, hay que compilar el 
script de  GarpDataSets. Carga unos datos (ver 2.1), haz clic en la ventana 
View, haz doble clic en el icono script, haz clic en la ventana vacía de script, 
selecciona menu->load text file, busca DataSubSetting.ave y presiona OK. 
Haz clic en el icono de compile (“V”) y despues en el icono “run” (hombre 
corriendo).  

 
2 Empezar un nuevo proyecto 
 
2.1 Abre ArcView, activa las extensiones Spatial Analyst y Geoprocessing (File-> 

Extensions->seleccionar Spatial Analyst y Geoprocessing->OK), y después 
activa la extensión GarpDataSets (File->Extensions->seleccionar GarpDataSet-
>OK). 

2.2 Carga los datos relevantes del medioambiente, sea archivos ASCII (File-
>Import Data Source…), grid o shape, por ejemplo desde www.worldclim.org. 
Asigna ubicaciones y nombres fáciles de recordar de los archivos. Cuando el 
script de GARP pregunta si los datos son enteros,  seleccionar enteros (por 
ejemplo categorías), seleccionar float (por ejemplo valores entre 0 y 1). Haz 
zoom a la región de interés.  

2.3 Si quieres usar información a priori dada por un experto acerca de la presencia 
y ausencia probable de una especie en el área, hay que construir un archivo 
ASCII grid para dar esa información a priori: 

 
2.3.1 Si ya tienes esta información a priori como archivos shape (polígonos; 

conviértelos a archivos shape si se requiere con Theme->Convert to 
Shape…), carga estos archivos y revisa que el valor 1 esta en los áreas 
de presencia probable, y 3 en los áreas de ausencia probable. Si no están 
así los valores, para cada de los variables haz así: seleccione el variable 
de la presencia (activa el variable en la sección legend del mapa), haz clic 
en el botón “table” (Open Theme Table), del sub-menu Table selecciona 
Start Editing…, cambia todos los valores en uno de las columnas a 1 (o 
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haz un nuevo campo para esto y da el valor 1 en cada línea de la 
columna), haz clic en el botón “Select None” (un rectángulo con 3 puntos), 
y del sub-menu Table selecciona Stop Editing (Save). Haz lo mismo para 
cambiar el valor del polígono (o los polígonos) de la ausencia a 3. Ahora 
junta los dos temas: View -> Geoprocessing Wizard…->Merge Themes…, 
y selecciona los dos temas para juntar. Traduce el nuevo archivo shape a 
grid (Theme -> Convert to Grid…); en “Pick field for cell values” selecciona 
las columnas que fueron cambiado a valores 1 (presencia) y 3 (ausencia) 
anteriormente. 

 
2.3.2 Si todavía no existen los polígonos de ausencia y presencia del experto, 

los puedes dibujar en ArcView así: del submenú Theme selecciona “New 
Theme”, da un nombre y una ruta donde guardar fácil de recordar. 
Entonces selecciona Theme->Start Editing… y selecciona el botón “draw 
polygon” del botón “drop-down” que muestra un punto. Dibuja los 
polígonos de ausencia y presencia a priori, tal vez ayudado por un Theme 
visualizado. Cuando ya están dibujados los polígonos (recuerda cuales 
son presencia/ausencia), selecciona Theme -> Stop Editing… Selecciona 
el nuevo Theme y haz clic en el botón Table (Open Theme Table). 
Selecciona Table -> Start Editing, cambia los valores en el campo ID a 1 
y/o 3, deselecciona todo (usando el botón con tres puntos en un 
rectángulo), y selecciona Table -> Stop Editing. Cambia el Theme a Grid 
(Theme -> Convert to Grid), y selecciona el campo adecuado 
(probablemente ID) en “Pick field for cell values”.  

 
2.4 Si todos los archivos ASCII están listos, hay que seleccionar una región 

cuadrada que contenga todas los covariables, y guardar las covariables en 
esta región como archivos ASCII. Del botón de dibujo, selecciona el rectángulo, 
y dibuja un rectángulo que cubre la región que quieres analizar. Selecciona el 
submenú GARP->Clip Datasets…, selecciona  una ruta para guardar para los 
archivos, selecciona “Selected Rectangle Graphic”, selecciona los temas que 
tienes que estar incluidos, haz “resample to a different cell size” (con un 
tamaño mas pequeño, los archivos se ponen más grandes), selecciona 
“Nearest Neighbor” y finalmente “ASCII grid”. 

 
 
3 Modificar un proyecto existente 
 
Frecuentemente uno quiere agregar nuevas covariables a un grupo de archivos 
ASCII, o por ejemplo escoger otro archivo ASCII grid para el a priori para 
acompañar los archivos ASCII grid de los covariables. Es muy importante para 
BioP que todos los archivos ASCII en un análisis sean del mismo tamaño, 
resolución y localización geográfica. Para adaptar estas características en uno o 
más archivos, sigues los pasos a continuación. En ArcView, selecciona un archivo 
ASCII grid que ya existe con el tamaño, resolución y localización geográfica 
deseada, y revisa sus propiedades en Theme->Properties. Anota los valores en 
los campos CellSize, Rows, Cols, Left (“longitud” de la esquina abajo izquierda del 
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rectángulo, llx), y Bottom (“latitud” de la esquina abajo izquierda del rectángulo, 
lly). Ahora calcula la latitud  y longitud de la esquina arriba derecha (urx y ury) del 
rectángulo así: urx = llx + (Cols-2)*CellSize, ury = lly + (Rows-2)*CellSize. Al tener 
cargado el archivo ASCII nuevo en ArcView, selecciona GARP -> Clip Datasets…, 
selecciona una locación memorizable para los archivos, selecciona “User-
Specified Coordinates”, da los valores de llx, lly, urx y ury. Selecciona la nueva 
covariable para extraer, da el tamaño deseado (CellSize como anotaste), 
selecciona “Nearest Neighbor” y finalmente “ASCII grid”. Abre el nuevo archivo 
ASCII grid (por ejemplo en WordPad) y revisa que las primeras líneas son 
comparables con los valores anotados (el procedimiento “clipping” va a cambiar un 
poco los coordinadas).  
 


